Paint enchanting characters
Talented artist YongSub Noh shares his techniques in Photoshop as he
conjures up and creates a stunning character.

Create Costumes
Enhance the dimensions of your character with Takumer Homma'’s
Photoshop painting guide to magical outfits.

Evolving characters
Richard Tilbury demonstrates his digital-painting techniques when
concepting characters who have evolved for arctic conditions.
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when it comes to designing

© . paintvilbinous
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T or you just want to brush up
b 4 on adding depth to your work,
then July’s issue of 2DArtist

is for you! Our vibrant tutorial
section this month is filled to the
brim with character designing

delights to guide you through

the process of creating your

own characters.

Whether you want to discover how to create and paint villains
to a games brief, which Charlie Bowater covers in the design
of the character Moonshine, or learn how to tie your character
into a narrative with the addition of costume and accessories
like Takumer Homma does in his step-by-step painting guide
to magical ouffits, this issue is on hand to provide you with

everything you need to know.

New this month is the first installment of a six-part series covering
the creation of a fantasy world by YongSub Noh. In this first
chapter this talented artist covers tips and techniques to create
and digitally paint a fantasy character to fit into your fictional

universe.

Alongside these great tutorials, we have an insightful interview,
a project overview of Landscape Speedpaint by Byzwa Dher, an
evolutionary character tutorial and, as always, visually stunning
work from some of the most exciting names in the digital world.

An issue not to be missed!
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Create Costumes
Enhance the dimensions of your character with Takumer Homma'’s
Photoshop painting guide to magical outfits.

Evolving characters
Richard Tilbury demonstrates his digital-painting techniques when
concepting characters who have evolved for arctic conditions.
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Contributors

Donglu
Yu

Donglu Yu is a concept artist
working in the video game
industry. Donglu has been

working on Deus Ex: Human

Revolution, Assassin’s Creed
Brotherhood, Assassin’s Creed Il and Assassin’s
Creed IV: Black Flag.

http://donglu-littlefish.blogspot.co.uk/

Contributing Artists

Every month many artists from around the world contribute to 3DCreative

donglu0419@gmail.com

and 2DArtist magazines. Here you can find out a bit more about them!

If you would like to be a part of 3DCreative or 2DArtist magazine, please

’ contact: jess@3dtotal.com

Charlie
Bowater

Born in the UK in 1988 and

raised on 90’s cartoons, Charlie

Richard

Tilbury

Richard Tilbury has had a
passion for drawing since being

a couple of feet tall. He studied Bowater spent her childhood

Fine Art and was eventually drawing her favourite characters

led into the realm of computers and insisting she’d grow up to

several years ago. His brushes have been dissolving be an animator. A lot has changed since then but
in white spirit since the late nineties and his graphics her love of art hasn’t. Charlie is an illustrator and
tablet has become their successor. Richard still self taught digital artist. She lives in Newcastle upon
sketches regularly and now balances his time Tyne and works as a concept artist for Atomhawk.
between 2D and 3D, although drawing will always be http://charliebowater.tumblr.com/

closest to his heart. charliebowater@hotmail.com
http://www.richardtilburyart.com

’ ibex80@hotmail.com

Takumer
Homma

Takumer Homma is a freelance
concept artist and a digital

illustrator in the entertainment

industry, who made a transition
from the automotive industry in
2012. He dreams and aims to work in films!
http://www.takumer.com/

takumer.homma@gmail.com

Would You Like To Contribute To 3DCreative
Or 2DArtist Magazines?

We are always looking for tutorial artists, gallery submissions, potential

interviewees, ‘making of writers, and more. For more information,

please send a link to your work to: jess@3dtotal.com
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“There are amazing
talents out there;
their creative energy
is also another
source of inspiration,
which keeps me
continuing on my
artistic journey”
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Donglu Yu talks to 2DArtist magazine about her career and techniques as a concept artist inthe gaming industry. Donglu

shares with us what it's like working with the creative team atUbisoft.



Donglu YU interview

Hi Donglu, thanks for taking the time to have
a chat with us! Could you tell us a bit about
yourself and how you got into the digital art
industry?

Hi, thanks for the interview, it is really nice to
chat a bit about my career path and what | have

doing recently.

First, | studied illustration and design in my
college years and film animation during my
university years, where | learnt digital tools such
as Photoshop, lllustrator, Maya and 3D Studio.
After graduation, | started working as a 3D artist
and texture artist, but soon | felt that | needed
more creative content in my daily job routine.
Since | had a solid painting background because
of the early training, | decided to make a switch
to concept art. | spent almost four months
building up my portfolio and applied to Eidos in

Montreal, where | got a job offer one week later.

What was it about digital tools that made you
want to work with them, and how do you feel
it enhances and helps you get feelings and
ideas across?

What | enjoy the most with digital tools is their
flexibility and fast-paced workflow. | am in an

industry where speed is everything; | can’'t

afford to wait hours for my oil paint to dry on the
canvas or to have coffee spilled accidentally on
my line work so | have to start everything over.

| started to move away completely from 3D; |

mostly use Photoshop and ArtRage for my job.

Photoshop can allow me to put down my
composition quickly, making changes to the
scale and adding photos as texture bases for
the paintings, and | rely on ArtRage to bring
back a little bit of that traditional painting feel to

my work.

Could you tell us about your creative
process and the software that you use?

The software that | use the most is Photoshop;
the new CS6 has the automatic backup feature
now, which is really useful when you have an
unexpected crash. Three years ago, | was still
used to starting some line work on paper before
continuing my painting in Photoshop, but now |

just start in Photoshop at the beginning.

| usually have two different approaches to

my paintings: starting with a black and white
thumbnail or starting directly with a photo
reference, which has an interesting architectural

element or intricate lighting.

I love the way you use the power of light

in your paintings. What it is about this that
attracts you and can you tell us more?

| find the right lighting is essential for giving an
immersive ambiance to a scene. Sometimes
good lighting can save you a lot of time

when paintings details, yet make the painting

emotionally more powerful too.

| have a lot of people asking me how | paint
lighting in my artworks. My answer is simple: |
always draw inspiration from photo references.
The good choice of lighting is not a result of
happy coincidence. The chosen lighting has to
showcase the focal point of your scene and the

story you want to tell.

The easy way is to pick an angle for the main
light source in a way that the lighting can directly
hit on one facet of your main subject matter

or backlight them. The others elements in the
scene can be supported with other smaller,
artificial light sources, the ambient light or even

the fog.

What do you feel is most important part of
this process that you like to focus on?

What | enjoy the most is the early sketching
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stage where | have to figure out the right
composition, color palette, lighting condition,
and silhouette of the architecture and the
characters. | can easily do a dozen of those
before starting the final paintings. | save all the
sketches; they are so valuable to me because
they are filled with my mind mapping ideas and
provide a visual record of the entire creative
thinking process. For me, in a way, they are

even more precious than the final painting.

Just a side note for the young artists building
their concept art portfolios: don't just include
final pieces in your portfolio, but also throw in
black and white thumbnails, silhouettes studies
and color/mood sketches. They can really enrich
your portfolio in the sense that art directors will
not only see your rendering skills, but also the

thinking process behind your artwork.

Where do you draw your influences from?

| draw inspiration from movies, books, games
and mostly from trips. | would love to have more
free time so | can travel around the world to see
different cultures. Traveling also gives me the
opportunity to take lots of reference pictures.
They are precious materials, which provide me
with inspiration for the subject matters that |

want to depict in my drawings.

| am also very informed about other artists in

the digital art field thanks to the different online
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Donglu YU interview

“For the young artists or
students who want to start
their career in the concept

art field, my advice is to

learn the art foundations
really well”
forums. There are amazing talents out there;
their creative energy is also another source of

inspiration, which keeps me continuing on my

artistic journey.

What has been the favorite project that you
have worked on to date?

My favorite project up to this point has definitely

been Assassin’s Creed |V: Black Flag. | had

the chance to work with the world-renowned

art director and artist Raphael Lacoste on this
game, and his input and involvement with the
project was a huge inspiration to the whole of

the art team.

The core art team also had a very solid pipeline
and experience with the previous Assassin’s
Creed titles, so they were constantly pushing
the technical limits for an impressive visual
result. Being part of such a team, | was able to
fully concentrate on the artwork and bring fresh
visual ideas without struggling with the technical
aspects. It was truly motivating to see how my
concept artworks were implemented into the 3D

virtual space.

Do you have any advice for anyone wanting
to start a career in the industry?

For the young artists or students who want to
start their career in the concept art field, my
advice is to learn the art foundations really
well, such as color theory, anatomy, drawing
from observation, and perspective. They are
important for both traditional and digital work.
Digital tools are great, but they won’t make
any magic happen just by themselves, so it's
important to have a solid understanding of those

art fundamentals.

It would also be helpful to attend different
conferences related to the entertainment

industry, as they allow you to make connections

¢
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with the professionals. You will be surprised how

these conferences can offer you some valuable

opportunities to step into the industry.

Could you tell us about any projects you are
working on at the moment or what you have
coming up in the future?

| can’t really say much about my current project
at Ubisoft because of the confidentiality policy,
but Assassin's Creed IV: Black Flag is coming
out by the end of this year and | can’t wait to

share some of my concept artwork with you.

Also, | have joined VFX Workshops to put
together a speed painting video tutorial; | have
really worked hard on this one. | didnt just
make a detailed explanation and demonstration
about my painting techniques, but | have also
shown what a concept artist’s daily job routine

looks like.

For anyone who is interested, you can go to the
VFX Workshops website for a quick preview
of the video: http://vfxworkshops.com/

instructor-workshops/donglu-yu/

Besides the full-time job, | have recently started
my own design studio, Pixel Belle, with my

husband Jack Zhang, who is also a senior artist

AR

“| think it is important to
focus on what you want to
draw in your portfolio, so
the recruiters and the art
directors can quickly see
your strength.”

in the game industry. We have been actively
bringing innovative visual solutions and ideas
for iPhone/iPad games, card games, book
illustrations, and CG movie concepts, just to

name few!

When you aren’t working on digital art and
concepts, how do you enjoy spending your
time?

As a mother of two kids, | enjoy spending the
rest of the time with my family. Nice walks
near the river, a picnic in the park or a tour in
the museum; these are the moments that |

extremely appreciate in my free time.

By the way, | think that my older daughter got

the artistic genes from me and my husband. She
is only two and half, and she is already addicted
to my Cintiq tablet and knows how to pick colors

in Photoshop!

| also enjoy cooking; preparing a tasty and

healthy meal for the family is a true pleasure for
me even though | don’t have the luxury of being

able to do it every day after work.

Working for a big company such as Ubisoft
is a dream for a lot of emerging artists.
Could you give any advice on tailoring
portfolios and what these companies are
looking for?

| think it is important to focus on what you want
to draw in your portfolio, so the recruiters and
the art directors can quickly see your strength.
You can focus on environments, characters,
vehicles or props. Build 80% of your portfolio
around only one subject and 20% around

others, just to hint that you are versatile.

It is also helpful to study the game titles that
specific companies produce to choose the
theme of your artworks. If you want to do
environments for Far Cry, make sure your
concepts are colorful with lot of open views

and vegetation. If you want to do a character
for Assassin’s Creed, make sure that you do
characters based on the history and the culture.
If you want to do props for Splinter Cell, make
sure your portfolio is full of modern weapon

design and vehicles, etc.
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What can you tell us about your experiences
at Ubisoft?

Ubisoft is a company which has a wide variety
of game titles; it is fun for the concept artists

to jump from one game to another in order

to embrace diverse designs in different time
periods such as historical, modern or sci-fi.
Ubisoft Montreal has a long history, so we can
find a lot of senior and worldwide-known artists
in the company. It's been a blast to know those
people in the productions and witness their
professionalism and talent in their own particular

field of expertise.

Within the production, concept artists are well
respected because of their strong involvement in
crystalizing and implementing the art director’s
vision. | really enjoy the daily interaction with the
art team, so we can bring innovative and fresh
visuals into the games with the support of future

next-gen technologies.

Is it difficult to design in a way that both
appeals to customers, while meeting your
own taste and expectations?

I think it is always the hardest thing in both
freelance and full-time production work. |

find that the best solution is to constantly
communicate your thoughts and ideas behind
the designs to the clients, so they are always
reassured that all of their essential design needs

are being fulfilled.
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Once they are reassured, you can squeeze your
personal touch into the artwork. For example, if
you want to make a more speed painting piece
of concept art, with bold brushstrokes, and the
art director wants a more realistic one it's not
because there is a personal preference for the
style, it is more because the modelers would
understand how an object is constructed much
better with a realistic and detailed painting.
Once you understand the reason behind the
requirement, you can reassure the art director
by saying that you will provide photo references
for your concept; he would then probably let
you go with a more moody concept instead of a

photo-real one.

How do you go about choosing the colors
in your work and what brushes do you use?
Are there certain ones you find yourself
using the most?

The choice of colors simply goes with the light
direction that | take. | usually start with less

saturated colors in my painting, without too

much contrast. So | will have the room to play
with the saturation just on the right spots where

the light punches.

For beginners, | suggest that they pick colors
directly from existing photos to understand
the intimate relation between the colors and
the lighting. Sometimes when you pick a blue
tone in the shadow and check that tone in the
Color Picker window, you will notice that the
tone is actually a mid-gray value. The lighting
condition around a specific color heavily
influences how your eyes and brain perceive

that color.

| am not the kind who gets too fancy with the
brushes in my daily work. The brushes that |
use the most are the simplest ones, such as the
round airbrush, charcoal, precise round brush
and a few generic texture brushes. They are
very effective and quick to use to build up the
base of my painting. Sometimes | do create

specific brushes for certain elements in different

contexts, such as vegetation brushes, building

structure brushes, and mechanical detail

brushes, etc.

Thanks for taking the time to chat with us

today!

Donglu Yu
\Web: http://donglu-littlefish.blogspot.co.uk/
Email: donglu0419@gmail.com
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“I'try to change medium
every once in a while, even
when staying with the
same topic”

f Is

Nicolas Weis, a dynamic visual development artist at DreamWorks Animation, who

has recently worked on The Croods, shares his doodles and scribbles with us in this
month'’s sketchbook.




Sketchbook of

Nicolas Weis

These sketches are a good example of
what | draw on a daily basis while working
in an animation studio, from a single, small
and sun-burnt plant, to a wide view of a
huge landscape. Both were drawn with
the same pencils and | had fun on both

assignments (Fig.01).

© The Croods is property of DreamWorks, and is used with permission. @




\ ‘ These sketches were the first images
that | did for The Croods, even before
| was officially on the show. The small
tree sketches are supposed to be
really big ones actually, and the main
inspirational source was the bonsai
collection of the Huntington garden

in San Marino. The big, weird-looking
flower concept just began with the word
“artichoke” after a conversation with
Christophe Lautrette, the production
designer of The Croods (Fig.02).
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© The Croods is property of DreamWorks, and is used with permission.
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These layout sketches were supposed to
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help figure out the different camera angles

we could use for the “new world” area (they
are about four inches long). | drew them next
to each other in my sketchbook to be sure

that they were not exploring similar ideas.

The tree on the lower right area was
designed for the first act of the movie,
a deserted, dry and dangerous region.
| decided to pose it like an animal to

accentuate its ominous aspect (Fig.03).
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These trees were the first
exploration for the kind of vegetation
The Croods would discover in the

lush jungle they would go through

after they left their destroyed cave.
The layout is the original | have

in my sketchbook; once again, |
worked with a series of drawings to
see how they interacted with each
other. The inspiration came from
different kind of trees: ficus, banyan,
sequoias and bonsais. | was

S looking for something whimsical,

i / “lush, gnarly, big, precarious and
| overgrown (Fig.04).
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Some graphite sketches for the design of a physical model
built by Facundo Rabaudi when we were looking for the style
of The Croods (Fig.05).

| try to change medium every once in a while, even when
staying with the same topic. | begin with a scribble or a splash
of ink and draw over it. It is a mix of control and intuition that |

really enjoy.

Issue 091 July 2013
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This would be good advice to give to anyone
who wonders what to draw: when you don’t
know what to do, do something, anything!
Unplug your brain and make a statement,
however minimal or abstract it may be. Then
explore the potential of this shape and push it

as far as you can (Fig.06).
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These graphite sketches were made for an old project |

had, a sci-fi version of Little Red Riding Hood, set up on

. ’ 1 an abandoned, overgrown Earth (Fig.07).
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Fig.08 was drawn in the south of France, in the convoluted and cool streets of [ |
Bargéme, Castelane and Roquebrune Cap-Martin, with the sun over my head.

This is the unique taste of vacation.




icolas Weis sk
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Fig.09 is a result of a fine night sketching with friends. | did the abstract splashes of watercolor,

then looked at them as if they were clouds, trying to figure out if they were trains, flowers or birthday
cakes. It turned out they looked like demons. @

page 2 ssue 091 ly 2013
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These sketches are a mix of copies from books
and internet references, and drawings on location
nearby one of the D-day beaches in Normandy.
After you spend more than 20 minutes drawing
tanks or any similar death machine you begin to
feel bad about how exciting they are to draw. If you
don’t, you probably have more serious problems

than perspective or the weight of your line (Fig.10).




| have been recently drawing a lot with ballpoint pens and | really enjoy it.
Not fancy ones; the kind you find on any desk. The scope of their potential
is really wide and it seems like every one of them has a special feel. Hence |

have been gathering and mentally labeling every one | used (Fig.11).




Life drawing is where | come from
as far as technique goes. A human
body will teach you anything you
need to know about perspective,
shape, volume, light, shadows and

composition (Fig.12).
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Here is another example of the abstract splash
technique. This time | used walnut ink and a few
drops of watercolor that | dropped when it was
still wet. | then used a quill for the line drawing
and eventually added some more watercolors
here and there (Fig.13).

It is a very fun and forgiving technique. You can
work the first abstract shape a lot as long as it

is still wet, and then use some water to partially
erase some of the lines done with the walnut
ink. It is a little bit like chasing imaginary animals

while gazing at the clouds.

page 33 ssue 091 ly 2013
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| have been drawing a lot of dragons recently, trying to incorporate non-reptilian shapes and characteristics. | drew all of them

on the Strathmore artist trading cards. Then | used watercolor and colored pencils. Once again, | tried to come up with a variety
of shapes, poses and then colors. The small size of the support forced me to go as straight to the point as | could and to focus

on the dynamic of the overall pose and on the cuteness (Fig.14 — 15).
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All these weird little creatures began
as a scribble that | did without look-
ing at the paper. Then it was just
a matter of picking the line(s) that
inspired me and lead me to the final

drawing (Fig.16).

Nicolas Weis
Web: http://www.nicolasweis.com/

Email: lekola@gmail.com
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Verus is Europe’s premier 3D printing company utilising a state of the
art Objet 3D printer.

Using Polyjet technology and liquid resin, our printer can produce
parts with an accuracy down to 16 micron layers.

This gives unparalleled surface finishes not seen in other forms of 3D
printing.

For more info visit our website:

Verus Precision Limited

www.verus.ie

Directors: No. 457312. IE9685043U
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Biological — Hereditary Memories of Other Worlds and
Universes

Edvige Faini

http://edvigefaini.com/concept-art

edvige.faini@gmail.com

(Above)

Contact

Luis Gama
www.luisgama.com
luisgama123@gmail.com
(Below)
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On the Run

Markus Lovadina

http://malosart.blogspot.com
malo74@gmx.de
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The Beach
Anthony Eftekhari

www.artofae.com

artofae@gmail.com
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Sometimes Even Reindeer Need a Break
Ludwin Schouten

www.ludwinschouten.nl

ludwinschouten@gmail.com


www.ludwinschouten.nl
mailto:ludwinschouten%40gmail.com?subject=

1 A
!1 41 Vo,

ISt Please submit your images to the LayerPaint gaIIery!'-",‘ 10 of the Best The Ga”ery

© 2013 SEILER All rights reserved.

+ Nenil Playing with his Ride!
Mohammad Keivan Marz
ht;p://mohamnad-keivan.cghub.com
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The Battle of Alesia

Jose Cabrera
http://brujulacromatica.blogspot.com.es
llowee@hotmail.com

(Above)
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One Way Ticket

Alexey Egorov

astron-66@mail.ru
(Below)
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Monster’s Friends

Aekkarat Sumutchaya
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Shapes, color and theory are an important part of character design. You can create a feeling of good or evil in visual design by changing the combinations that you use.
In this tutorial series each artist has been presented with a games-like brief describing a hero or villain, and their challenge is to use this brief to design a character while

conveying the elements that make them recognizable.



Heroesiand.\Villains chapter 02= Moonshine

Photoshop

Character design is easily my biggest
painting passion. What can | say? I'm in love
with painting people! | always find painting
characters fun, but painting a villain? It's the
perfect opportunity for having that little bit

of extra fun! The starting point for my villain,

Moonshine, is a brief description:

“This character carries a tank or cylinder on his
back, attached to a hose that fires flammable
liquid similar to a flamethrower. His appearance
is shabby and he wears a large, overhanging

hat that helps obscure his face.”

Exploration is an important part of any character
creation — a little experimentation will give you

a nice selection to choose from — but | have to
admit that | usually picture the sort of character

I’'m aiming for instantly.

After reading the description of Moonshine |
already know what | want to go for: something
leaning on the side of stylized rather than
realistic, purely because it's going to be a hell
of a lot of fun! Perhaps it’s harking back to my
Disney years, but | do love a good villain. With
a little stylization | can exaggerate his features
and throw in some bright pops of color, both of
which are appealing to the idea | have stewing

in my head.

To start with I'm blocking in some rough
silhouettes to try and find the pose and shape
of the character. | want to get this part nailed
first so that I'm completely happy with the pose
before | start playing around with any of the

character’s features.

| don’t have a specific pose I'm aiming for, but
I’'m trying to keep in mind that this is intended

to be a character design rather than purely an
illustration. This means that | want to make sure
you can see as much of him as possible, clearly,
while avoiding just sticking him in a boring T

pose (Fig.01).

www.2dartistmag.com
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| do it so much it seems a given really, but don’t
forget to flip your image! Flipping is a great way
to gain a new perspective on a painting. It really
helps when noticing mistakes; they usually stick

out like a sore thumb once flipped! Try and do

www.2dartistmag.com

Chapter 02 = Moonshine Heroes andiVillains

this every hour or so, that way you won'’t reach
the end of a painting and realize it looks terrible
flipped the other way (Image > Image Rotation >

Flip Canvas Horizontal) (Fig.02).

| haven’t quite set my sights on one idea

in particular at this point, so I've duplicated
Moonshine a couple of times. This means that |
can try out some variations and different ideas

on his character.

As | mentioned before, exploration is key.
Rather than sticking with one idea at the start
and then potentially changing different elements
of his design throughout the painting, it's much
more logical to experiment at the beginning and
develop the ideas you like best until you settle
on a final design. You can always add in smaller

elements as you develop the painting (Fig.03).

So here we have a few variations on
Moonshine. There are different elements that
| like about each of the designs, and | think a

mixture of them would work well together. | like

page 52

the overall shape of the middle iteration. | think
he’s got enough contrast within his shape to

make him interesting.

| also particularly like the welding visor in place
of a hat. | do like large, overhanging hats

but I'm bending the rules and going with the
visor — | just think that it looks the best out of
the options. | really like the fire extinguisher

as the flamethrower tank, but I'm going to opt
for the second one. I'm thinking ahead and |
know | could throw in a vivid pop of color for
the flammable liquid — if | go for the clear tube
option (Fig.04).

So now that I've roughly mashed together my
favorite elements from the different Moonshine

iterations, it's time to start working on the color!

Moonshine himself is on a single layer that’s
separate from the background. | normally like
to keep my layers fairly flat, but for this purpose
I’'m going to keep the figure separate because
it will be handy later on if | decide to throw in

any textures over the top. For now, I'm adding

meoStuy20s
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in the base colors. I'm doing this by blocking in
the sections of color on a layer underneath the
character (Fig.05).

Step 6: Keeping it Rough for Now
Now that the base colors are done | flatten the
two layers together and get started on adding
some basic details. I'm keeping everything
pretty rough at this point. | want to build up the
general form of the character without getting too
detailed at the start.

NSNINE

| stick with brushes that have a bit of texture to
them; hard-edged, chalky brushes are a winner
with me. | think they add a nice bit of texture to a
painting; | like to see hints of brushwork. I'm also
intentionally keeping things rough as | find that
helps with the male form in general. | don’t want
it to be too smooth (Fig.06).

Step 7: Mixing Different Layers
Now that I'm pretty happy with where the

character is going, | spend a bit of time building

up the detail on Moonshine’s face. I'm still trying
to bring out that crazy expression and villainous
side. I'm using a mixture of opaque layers and
I’'m also occasionally adding in an Overlay layer.
| tend to use Overlay layers every now and then
as they’re a great way of warming up the tones
in the face (and body, if need be). I'm adding in

a little red to the nose and ears (Fig.07).

Step 8: It’s all in the Expression

A character’s face is a part of a painting that

| normally spend a lot of time working on. It's
always important to me that the character has
a good expression, be it a somber one or, in

Moonshine’s case, a bit of a crazy one.

| really want to bring out his personality and

| imagine him to be a little bit deranged; he’s
a villain after all! So I'm giving him a sadistic
grin, along with crazy, wide eyes and furrowed
caterpillar eyebrows. Expressions can be so
much fun, so make sure you play around with
them (Fig.08)!

Step 9: Texture, Texture, Texture

| like to add in textures throughout the painting
process. | think they work better by layering
them up and painting them back into the
character, rather than just slapping them on

at the end. I've picked a few different grungy

textures and I'm putting them over the top of

‘ Moonshine. Make sure to right-click that layer
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and select Create Clipping Mask. This way you
don’t have to worry about erasing the edges
around the character. Then just drop the opacity,
erase sections you don’t need and play around
with the layer modes (Fig.09)!

Step 10: Think About his Character
It seems obvious really, but if you're designing
a character, then think about their personality
throughout the painting. You'll find yourself
having light bulb moments and thinking of
elements you can add to really bring out their

character.

Moonshine should be a bit of a scruff, so I'm
gradually adding some dirt and grunge to his
clothes; and I’'m making sure they’re all pretty
worn and frayed. Then I'm just adding in some
fun little details: an outdoorsy-type tan line and
an auto shop-style name badge. They might
suggest what he gets up to outside of his villain
duties (Fig.10).
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Step 11: Painting the Fabric

| don’t have to worry too much about painting
Moonshine’s t-shirt in much detail; it's pretty
form-fitting and a few strokes to suggest some
creases will suffice. As for his trousers though,

they’re pretty baggy and heavy by the looks of

them, so they create a lot of folds and require

some more detail.

With fabric | always try and keep in mind the
weight of it and imagine how it folds over itself.

You can stylize and simplify it to a certain
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degree, but it helps to build up a little visual
library of how it should look so references are a

great resource (Fig.11).

Step 12: A Little More Texture

Now that I've painted up the folds of
Moonshine’s trousers they're looking a little too
neat and | really want to emphasize his grubby
side. So I'm throwing on another texture! I'm
putting it on a layer above Moonshine and
setting it to Clipping Mask.

Again, you won’t have to worry about erasing
the parts you don’t need. Drop the opacity a
little and even add in another layer if you think it
needs it and voila, his trousers are messy again
(Fig.12). All of my textures are coming from
cgtextures.com — a great free library, just make

sure you’re using textures you’re allowed to use.

Step 13: Adding Some Bounce Light
| nearly always like to add in a secondary light
source when | paint characters; you can have

a lot of fun and build up form with other light

sources, and bounce light. | kind of think that

File Edit Image Layer Select Filter Anabysis 3

\ | ‘l Y C J \ )
|C Vr”r:l’ |S' Chapter.02 = Moonshine

Moonshine doesn’t need an entire second
source though, so I'm adding a couple of smaller

bounce lights.

I've made the tank of fluid a really bright color

and it looks a little like it's glowing, so I'm just

adding a little bounce on his arm and that side
of the body where the light would hit (Fig.13).

Step 14: Last Minute Texture
So we’re pretty much at the end of the painting

and the illustrator in me can’t bear to leave poor

T s

PAINTING 3%

O csuve- (=]

»
300

~ [ |Mode: Brush ~ Opacty: 1005 [+ | @ | Flow:| 100

MoonshineColours (1).psd @ 50% (Layer 38, RGB/8) * | i
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Moonshine with such a plain background, so I'm
throwing in some last minute texture along with

a subtle pop of color.

This is where keeping Moonshine on his own
layer will come in handy; it means | can tweak
the background without disturbing the character.
I’'m splashing on a bright orange with a nice
raggedy textured brush, and then throwing a
texture over the top of that on a Clipping Mask
layer. A little tweaking of the opacity to tone it
down slightly and voila (Fig.14)!

Step 15. The Final Touches

By now I'm pretty happy with the overall
character. I'm just adding in a few final touches,
which, to be honest, normally take the longest

amount of time!

For me this is just a case of slowly working my

way around the painting and working up those

details, like belt buckles and the fun little extras
like the temperature gauge on his tank. And

of course, I've given him a little flask of booze;

5 "A (¥

naturally it's moonshine. | love detailing so it’s a
lot of fun, and that’s just about it (Fig.15).

| hope the tutorial was helpful and that you enjoy

working on your own villains!

Charlie Bowater

Web: http://charliebowater.tumblr.com/

Email: charliebowater@hotmail.com
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In this two volume series, Scott Patton shows the processes he usesto
create a 3D character for feature fll&%IThe first volume explores
Patton’s fast and efficient method for concept sculpting, skipping the
2D sketch phase all together and designing the character entirely
within ZBrush®. He covers everything from blocking out the forms
and fleshing out the muscles, to adding props, detailing with alphas
and posing the character. The second volume covers methods for
creating a final color rendering using ZBrush and Photoshop®. Patton
shows how he squeezes the most from ZBrush’s powerful renderer to
create both a wide and close-up shot of the character. He then shares
creative Photoshop tips and tricks to quickly get to a finished piece of
concept art from the ZBrush renders, covering topics such as adding
and refining skin texture, hair, eyes, shadows and scars. Patton also
discusses how to create backgrounds that enhance the character and
overall composition.

All Tutorials Are Now Available
As DVDs, Digital Downloads,
And Part of The Online Training Subscription

www.thegnomonworkshop.com
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Learn the All Important Fundamentals

comPLETE
LLUSTRATION

ONLINE VIDEDOS
AND DVDs

nlike most videos on art

which teach Techniques and
Special Effects, these videos
teach you the Core Fundamentals.

Once you know the Fundamentals
you have the tools with which to
create any kind of art you want.

There are 4 courses availahle
that make up the Complete
Illustration Art Course.

You get Unlimited Access to all
the videos with no study time
limit. At last you can get a
complete art education for

www.onlineartacademv.cnm an unprecedented low price.


http://www.onlineartacademy.com
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FANTASY
== WORLDS ==

Fictional universes are often used in games and films, with fantasy being a popular theme! They are made up of many different features such as characters, environments
and vehicles, and it is important that all these elements work together to create a believable environment and society to engage the audience. In this series our artist will
take a comprehensive look at creating a fantasy world from a concept perspective, and investigate the processes and techniques that can be used to create all the major

features of a game or film.
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Chapter 01 - Characters
Software Used: Photoshop

My “new world” will cover the theme of medieval
European fantasy, which famous works like

The Lord of the Rings, Guild Wars and World
of Warcraft are also based on. The reason I've
chosen this is that it's one of the most popular
themes used in modern digital art and therefore
all concept artists should either encounter it or

use it at some point in their work.

The Concept

The first step is just thinking about the character
in your head. | first think about the main
characteristics of my figure and decide to create

a female elf assassin.

I've chosen this primarily because drawing
female characters is more interesting to me.
The elf is a famous and typical race within the
fantasy realm and assassins wear light armor,
which gives me the opportunity to practice a

range of materials.

Before we start, | will briefly show you how |
set up my Photoshop work space. This is just
one sample reference, so you don’t have to
follow exactly what | do. You have got your own

working style, so set it up as you like!

As you can see in Fig.01, my software is
Photoshop CS6. From the screenshot you can

see three types of brushes and a floating Color

Picker with HSB sliders. | like using the HSB
sliders as you can set the color with H, adjust
the brightness with B and adjust the chroma with
S. It’s a little tricky when adjusting values on a
small tap area, but it can be handy when you

get used to it.

There are many convenient plug-ins out there,
but I'm an old fashioned artist using only default
functions in Photoshop and | just customize
them to fit my own preference (Fig.02). | click on
Transfer and change the pressure option to Pen
Pressure for those three brushes. For the leaf
brush, | check Shape Dynamics and Scattering,

and allocate appropriate values.

Aside from that, there’s no special setting aside
from assigning a few hotkeys, expanding History
States from Preferences and un-checking the

Use Graphics Processor box.

The reason why | suggest this simple and

plain setting is because | want you to focus on
improving your basic skills rather than getting
techniques from the actual tools. There are
many different settings and various external
plug-ins, but as an experienced artist, | suggest
that you concentrate on improving basic skills
first. Basics are always first, learning techniques

are secondary.

Now our workstation is set, let’s begin the

concept art!

First of all, refer back to your initial character
idea. You don’t have to iron out all the details
at this stage, even in your head — all you really
need in order to get started is a basic outline
that you've taken from your imagination. The
details are bound to change as soon as you

progress anyway!
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First, paint the whole canvas with a single color

(Fig.03). This will emphasize your artwork just
like a decoration. Of course, this is my style in
drawing concept art. You don’t have to follow
exactly what | show; please indulge your own

creative impulses!

My canvas size is 6000 x 8000 pixels and the
resolution is 300 dpi. It's a huge canvas, but

by having this size, | will be able to draw in
great detail and so fit my outcome to various
purposes. Your artwork might happen to
become a poster or a printed material, so small-
sized artwork might bring trouble in the future.
Resizing the size from large to small is not a
problem, but the opposite is not so easily done,
so have a canvas as large as your PC lets you.
Now let’s begin to sketch out the silhouette onto

the canvas.

You can either add a layer or you can have the
background and character sketch on the same
canvas. For me, | just add one layer above the
background and sketch the character. At this
stage, you only need to set the outline, pose

and composition.

You can just start with the line sketch, or you
can scan it from a paper sketch. | prefer to

sketch with a thick brush rather than with lines

(Fig.04). It's simpler and faster for me to sketch

quickly and with bold strokes.

Beginners usually get timid at this stage. You
might have some awkwardness and flaws now,
but it will be polished up as you work so don’t

worry too much now: just have a go!

Most of this image is sketched with the hard
brush | set up at the beginning, though the softer
skin sections are created with the soft brush with
minimum hardness. It’s better to use different
brushes for different purposes. Try as many
different brush settings as you want in order to

find the brushes that fit you.

| then start adding a rough sketch for her
costume (Fig.05). At this stage, you have to
consider the direction of the light. | set the light
in my image to originate from the upper-right

side of the canvas.

The costume design is now becoming more
apparent. To add a little visual fun, | choose to
draw unbalanced pants. | draw the outline of her
face and set the position of her eyes, nose and
mouth (Fig.06). The point is not to focus on a
detail, but draw a broad, overall silhouette. This
way, you can get a good balance and continue

the work with a proper stable base image.

As | have set the color tone to dark and plain in
order to set the general mood, and have most
of the shapes sketched in, the costume design
starts to get a definite style. I've also come up
with a special idea: the crow feather! | think it fits

really well with the assassin’s image (Fig.07).
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Now we are moving toward the stage where
the final image starts to take a more solid form
in your head, and can begin adding in details
(Fig.08). Again, unless you are a creative
genius, don't try to set every detail from the first
stage of the sketch. It is just way easier to do

it like this. Get to the details as you draw and

develop the image!

Fig.09 shows how our image is becoming more
detailed, and gradually coming out as a concept
artwork. It’s in the final stage of basic design.
Now let’s focus on her face. The most
sophisticated and difficult parts to draw are

those fine features on the face (Fig.10).

When people are first introduced to a character,
they always naturally and instinctively study the
face first, so viewers will instantly notice any
awkwardness present in your image. Since a
human face is made up of so many delicate
bones and muscles, it’s a really hard part of the
body to draw from your imagination. Now would
be an excellent time to look more deeply into the

anatomy of the face.

Having a photo to refer to can be a nice solution.
Don'’t refer to pictures by other artists, as they
often have exaggerations and don’t provide
accurate information. | also advise you not to
take pictures as a reference until you master the
basic skills. After you have mastered the basic

skills, you will be able to pick up on those slight

accents in artists’ pictures.

It's important to check the harmony and the
consistency between the details and the whole
image while you draw the face. To do this, open
another canvas window from Window > Arrange
> New Window for “filename” (Fig.11). Try to do
this for all other parts of the body too; remember
that if the balance collapses on the face or body,

great expressions or details are lost.

Next, it's time to | begin polishing the

awkwardness in her pose, the ratio of her body

and adding in some other details.
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Originally, | planned to depict her in a full crow
feather cloak, but have changed my mind and
simply follow a more common cloak design
(Fig.12). As the polishing is being done, you
can change small details like this to suit your

preferences.

Now we’re slowly working towards a greater
level of detail. You have to make the most of
each material’s characteristics, such as metal,
leather, fur, feather, skin, etc. Referring to

photos will help massively here (Fig.13).

The key factor that defines the feature of each
material is light. If there’s no light, you can’t
perceive the color, shape and material of an
object. Understanding this principle is the key to

creating realistic textures.

Usually, metals reflect light very strongly, so |
give more contrast and strong highlights to the
metallic sections in her armor (Fig.14). Fur is
soft and absorbs light, so | give less contrast
and weak highlights. Leather and feathers

are somewhere in between, so they get a mix
depending on their relation to the light source.
For the leather, metal and rough touches in the
background, | use the leaf-patterned brush | set

up at the start.
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The best way to determine the placement of
these strokes in pictures is to observe and

learn from your everyday surroundings. Only
by continuous observation will you be able to

express them properly.

Now we’re getting closer to the end. |

finish polishing the many details and the
characteristics of each material in her costume.
In reality, very few details have been changed:
now only one horsetail decoration remains and
a few more colors have been added. | polish

the angles and skin on her face, put a little more
effort into the texture in her hair, and stretch her
legs to make them a little more in proportion with
the rest of her body (Fig.15). Now is the time to

check the overall balance.

As | mentioned before, one of the most
important factors in your image is light. As you
started from the dark, you have to work towards
and finish with the bright highlights. Eventually,
the concept can be completed by finishing the

brightest part.

In my picture, | tune the Level option to increase
the overall contrast (Fig.16). With Photoshop,
you can add so much to your digital artwork. In
drawing and designing, the best and the easiest
way to master character creation is simply by

drawing a lot!

YongSub Noh
Web: http://yong.cghub.com/
Email: subzzang@gmail.com
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-COSTUME DESIGN-

Costume design is an important element to character design as it helps to enhance a character’s personality. You can create an evolving plot of color, changing social status,

or period through the visual design of garments and accessories. In this tutorial series each artist has been presented with a games-like brief describing a character from a

certain section of a fantasy medieval world, and they must design clothing suitable for that character’s job description.
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Step 2: Start With a Loose Sketch

| start by establishing an overall pose, working
very quickly and focusing on gesture to get a
feel for her character. It is basically a gesture
drawing and it helps me to get a vague idea of

the character, but things can change later on.

| am not painting a background for her, so it
is faster and gives a more defined look as a
result. This also allows me to really focus on the

subject and enjoy designing.

At this stage, | start thinking about words to
describe the character, such as elegant, opulent,
confident and sharp, etc. | am trying to translate

it visually in her gesture to set the look.

Step 3: Add Value Masses

Here | am just blocking out with masses of dark
values to give volume, working very fast and
loose. I'm not worried about filling it with solid
color just yet; | like leaving spots of lights to give

some room for happy accidents.

From the first two steps, | have an idea that

she would be wearing something tight to her

body and so it is important for me to think about

her anatomy. | am also starting to think about @
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breaking her silhouette by adding a headdress,
just adding a mass to remind myself to re-visit

the head area.

| usually start with grayscale, which allows me
to focus on design and not be struggling with
getting the colors correct. Usually in a first
concept design review, | deliver my work in

black and white with value break-ups.

Step 4: Begin the Design

| create a new layer with a white fill. | then layer
it on top with a slight transparency, so her body
is slightly see-though. Because the overall pose
and the body is established underneath, | can

now focus on dressing her up.

| start with a simple dress and | imagine her in
heels so she stands tall. | add a major shape
around her head, almost like a standing collar,
but with a raven wing outline. No details yet, just
some hints of what it could be and making some

marks that may be used or not.

| start sketching her face to see what she could
look like; she doesn’t have the right feel yet. |
will be spending some time on the face later

because it is a very important area of focus.

Step 5: Roughing in the Design

| continue to work on her face, which is giving a
better feel. | then start to look at some graphical
break-ups that are simple and directional. The
main focus here is her face, so | am trying to

keep the lines flowing upwards. | find it better to

o

keep this simple and not over-complicate it with
over-crowded lines. | always remind myself that
this is not a texture; it is more like an internal

silhouette and material break-up.

| start roughing in some details on her head. | do
not like the approach, so | will be painting it out
later on after | understand more about the rest

of the design. It is a place-holder for now.

Step 6: Add Details

Remember to flip your canvas every now and
then; it will give you a fresh view of your work
and make it easier to spot problems. | use it
often, so | have created a keyboard shortcut by
going to Edit > Keyboard Shortcut. It is a very

useful tool to keep me refreshed and awake.

| start exploring some details, and | start to

add some pointy elements and hints of chains
to give it the cold and dangerous feel. | leave
the head piece for now, although | am thinking
about it while | start to work on other areas. This

can lead me to accidental ideas, so | am not in a

@ hurry to solve this.
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Step 7: Using Color Balance

To add an overall color to a grayscale image,

| like to use the Color Balance from Image >
Adjustments > Color Balance option. | cool
down the piece and start working on her skin. |
create a new layer with a Soft Light blend mode
on top and begin to add some skin colors. It is
looking a bit too warm at the moment, but | can

easily adjust this later.

| usually create another layer on top and actually
paint in some colors to get a raw and vibrant
look. Particularly on the flesh tones to avoid the
colors looking de-saturated, | add yellow, red

and cool colors.

Step 8: Create a Custom Brush

Here | extend the canvas to give me more
space to work, so | am not restricting myself
with design. | start adding magenta to give a
poisonous feel and re-visit her headwear design.
| am looking at a more specific hood with a stiff
frame sticking out, with lappets draping on the
sides. It is very rough, but clear enough to see it

coming along with the dress.

| decide that | want more chains in her costume,
and there is a specific chain link that | have in
mind. | create a shape of a single link with solid
color on a new layer, and to create a custom
brush, | select the shape and go to Edit > Define
Brush Preset. | then go to the brush setting and
adjust Brush Angle to 90 degrees and the Space
to 210%, tick Shape Dynamics and set the

Angle Jitter control to Direction.

Step 9: Refine and Change

| flip the canvas again to make sure that my
decisions are working. Using the new chain
brush, | add chains to her dress and to the
thurible. | want something light as her weapon
to go with her character, and | also add a staff to

hint at her occupation.

| work on the details more, slowly building it up

to a more presentable piece. Bear in mind that

o
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this is more of a suggestive painting to convey
an idea and is not a perfectly resolved design
piece. Suggestive painting is useful for painting
something quick and moody, which is very

useful for the first round of reviews.

| pay a little more attention to the wing around
her head because it is a major part of the

character’s design.

Step 10: Final Touch Ups

| finish the overall design and get the look that

| was after; from here it is all about rendering
and being decisive. | decide to make some final
design decisions to make sure all the design

elements are strong and clear.

| start looking at the secondary elements in the
image: her staff and thurible. | really want to
add more raven elements into the design, so |
introduce the claws to her staff and a wing to the
thurible, almost like she has trapped a raven in

the censer.

| get rid of the cloth behind her because it wasn’t
functioning very well. For a final stage, | change
the direction of the thurible, the smoke and the

wing collar for compositional purpose.

Takumer Homma
Email: takur.homma@gmail.com

Web: http://www.takumer.com/
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When designing characters for movies or video games, it's important to think about the different possible worlds and how a human character could have evolved to

cope with his/her environment. In this tutorial series, each artist will take us through their design process, exploring a variety of factors that would effect and influence the

character’s evolution and anatomy, to convey a visual idea that could be passed on to a 3D modeler or art director.



hapter02="Arctic

Chapter 02 - Arctic
Software Used: Photoshop

Introduction

The idea behind this tutorial was to design some
characters that look as though they had evolved
to survive in an arctic climate where conditions

were extreme.

Obviously the environment was a determining
factor and would dictate many of the decisions
with respect to the costume design, but
alongside this were the cultural issues which

would also have an impact on their appearance.

Because polar regions prohibit the growth of
crops and food stuffs that other parts of the
world take for granted, it does mean that the
inhabitants rely mainly on meat as their primary
food source. This type of environment has a
very limited number of resources and as such,
the people there have evolved to hunt for food,
often requiring them to travel long distances in

harsh conditions.

www.2dartistmag.com

Undoubtedly the cold is perhaps the
greatest threat and therefore this was a key

consideration when designing the clothing.

The indigenous people needed to be able to
survive for lengthy periods whilst navigating ice
flows and freezing water and so their clothing

needed to reflect these factors.

Thumbnails

The first stage in the process involved doing a
sheet of thumbnails exploring numerous ideas
and designs. In many ways, this is the most
important part of the design process as it sets
a precedent for the final concept. Although

the concluding design may deviate from the
preliminary sketches, it generally reflects many
of the initial decisions and ideas. Generally my
finished concept is an amalgamation of various

aspects taken from different sketches.
Starting on a small scale by creating what is

termed “thumbnails” is useful to quickly draw

as many figures as possible. It can either be
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done in line or alternatively you can opt to draw
in silhouette fashion, which is equally valid.
Sometimes the shape of an object is more
descriptive than the culmination of details and
so working in this way can open your mind to
different interpretations and help you to see

things unimagined.

This can be approached using a group of
random marks and brush strokes, which are
then “hewn” by way of the eraser to approximate
the shape of a character. Once this is
established you can then go on to flesh out the

details or draw in the line work.

Fig.01 shows an example of how two characters
can begin as silhouettes and then be detailed
using line. There are numerous ways to interpret
a silhouette and often it is worth roughing in a

few designs based upon a single thumbnail.

An alternative method is to aim somewhere
between the two approaches and use shapes to

delineate the detail.
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Fig.02 shows an example of this whereby a
silhouette was blocked in first and then some

evidence of clothing added over the top.

Fig.03 shows a final set of character thumbnails,

which start in the upper left with a more

www.2dartistmag.com

conventional costume. The two left characters
on the second and third row also look quite

conventional, but in a more Lappish style.

Whilst sketching | was thinking about ways in

which people could keep warm and the types

I i
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of materials available to them, the obvious one
being animal fur. | also considered how clothing
traps our body heat and bounces it back onto
or skin, and how by wearing multiple layers we
can keep warmer. As a result | made many of

the characters look plump and well padded,

Issue 091 July 2013



http://www.2dartistmag.com

ArctiIC

hapter02

incorporating air pockets within their clothing to

trap heat.

As well as this principal | began thinking
about how people have used heating ducts
in conjunction with wood burners in order to
transfer heat around their homes, and the

principles behind a boiler.

With this in mind | started to place canisters and
tubular accessories on a number of characters
to explore the possibility of suits incorporating
slow-burning fuel that could be used to warm the
clothing for long periods, such as carbon-based

elements and animal fats.

The other benefit of having air-filled pockets
around the body was that if a person fell into the
sea through thin ice, for example, the suit would

act as a life jacket and keep them buoyant.

Sketching
Once | had established a few ideas during the
initial stage | began making some larger scale

sketches to explore these in more depth.

| liked the idea of padded clothing that contained
small air pockets that could perhaps serve to
circulate warm air around the body. In Fig.04
you can see two variations based upon these

notions, which also show headgear to insulate
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the head. | included some fur on the upper

character as well as giving the other person a
harpoon to prevent the costumes looking too

“high tech”.

Another aspect | considered was some form of
protective face mask or breathing apparatus for
use in particularly harsh weather and blizzards.
Ice usually forms around the nose and mouth

due to exhaling warm air and so something to
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alleviate this would be greatly beneficial. Of
equal relevance was something to help reduce
glare and protect the eyes, and so | went on to
incorporate both of these ideas into the following

three sketches.

Fig.05 shows a character wearing a protective
face mask and goggles, as well as some
shoulder fins to shield against harsh winds and

driving snow. He also incorporates padded

Issue 091 July 2013


http://www.2dartistmag.com

hapter.02 = Arctic EV.O1

clothing and some extra insulation around the

hands, which are always vulnerable to the cold.

Fig.06 takes this type of design a step further,
giving the costumes a more sophisticated
appearance and also suggesting the inclusion of

some technology.

Although | liked some of the aspects to

these, Fig.04 — 05 did resemble pilots and
maintenance crew, which was not my intention.
| did not want to create a science fiction-
looking character, but rather wanted to show

a civilization that had somehow evolved to

harness some of their available resources.

Having a Blend

There are always certain things you like and
dislike about each design, but this process helps
filter these aspects down to the ones that are

more preferable or appropriate.

Final Designs
Having explored various avenues | had a good
notion of which characteristics to include in the

final version, which are as follows:

» The use of animal fur and leather obtained

from hunting

www.2dartistmag.com
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* Some version of face protection or
breathing apparatus

A form of heating that helps keep the body
warm on long journeys

« Clothing that contains heated air pockets,
which also act as a good buoyancy device

when in water.

Fig.07 shows the initial block-in of the first of
two designs, showing a conventional fur hood
and a skirt that wraps around the legs for extra
protection against harsh weather. This can be
opened via the small rivets when the person
needs to run or travel quickly or alternatively

closed for walking and bad conditions.

There is a belt around which supplies and
fuel can be hung, as well as a chest-mounted

canister from which to deliver heat into the suit.

As you can see, | began working in black and
white and then moved into color by way of a

Multiply layer.

| gave one of my thumbnail sketches some
snow shoes, but instead of the antiquarian
“tennis rackets” | decided to create boots with a
wide padded base to help disperse weight over

the snow and ice.
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In Fig.08 you can see a more advanced state

with the canister in a better perspective and
connected to the suit via a small hose. The
boots have spikes around the sole which will

help grip on to slippery surfaces.

For the final version of the first character, |

added a face mask for protection, as well as
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some decorative patterns across the skirt to add

interest (Fig.09).

The second character utilizes other components
from the thumbnail sheet, including the three
seen on the right in Fig.10. As previously
mentioned, my final designs tend to be a hybrid

of various sketches.

In this case | wanted to create a more unusual
appearance and so combined a mixture of
reasonably advanced-looking components with
more primitive ones. In this case the heater,
located at waist level, is connected to the

headgear via a pipe that wraps around the torso.

This character also boasts a face mask with a
protective visor, which can be detached and
separated into two pieces. In fine weather it
can be removed entirely or alternatively the left
or right section can be attached separately to

shield cross winds.

One thing that has not been mentioned is
physiology and the ways in which an arctic
climate affects the human body. Generally a

compact build conserves warmth and an optimal
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distribution of body fat is important to keep vital

organs warm.

As my characters were well padded it made
it quite difficult to portray their anatomical
appearance, but a short, stocky physique

seemed appropriate.
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Their diet would consist almost entirely of meat

and fish, much of which would need to be eaten

raw in order to get vitamin C.

At this time my characters were looking too tall
and slim to fit this description, but | knew | could

use the Warp tool later to modify their anatomy.
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Once the general shapes were blocked in, |
began clarifying the headgear and mask as well

the boots and equipment (Fig.11).

Fig.12 shows the initial color stage, which
was once again applied on a new layer set
to Multiply. Once | was satisfied, | flattened
them and continued adding more details
and refinements on additional layers before

repeating the procedure.

From here it was a short step to completing the
character by building on what had already been
established. Although the final versions are not
replicas of any one thumbnail or sketch, they do

borrow from the initial ideas.

| added a secondary hose feeding into the
circular breast plate, which would deliver heat to

the center of the torso and major organs.

www.2dartistmag.com
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| also added a Curves adjustment layer to
increase the contrast and place highlights

across the right side of the character (Fig.13).

Finally | used the Warp tool to shorten the
character and give him a more compact
stature, which would help him to survive in

the cold climate.

Richard Tilbury
Web: www.richardtilburyart.com

Email: ibex80@hotmail.com
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“When creating a speed

painting | focus on what

is clear according to the
title of the '

SPEEDPAINT

MAKING OF BY BYZWA DHER

Freelance digital artist Byzwa Dher, shares some of his thought process and techniques to create

landscapes in this step-by-step project overview of his image Landscape Speedpaint.




Landscape Speedpaint
Software Used: Photoshop

Introduction

When creating a speed painting | focus on what
is clear according to the title of the scene. It is

a fast method of painting without significantly
refined details, where the result is basically a
sketch with clear composition, colors and light.

This sketch can be used for further repainting.

Personally | really like this method because the

painting arises very quickly and it mainly catches

the atmosphere that | want to put across to the

viewer. | am a big fan of impressionism and that

is why my final stylization of the painting can be

reminiscent of this style.

Thought, Preparation, Thumbnails
Every artist has probably been met with the
obstacle of: what will | paint? First of all | had
to help myself a little bit. | used some methods
that could turn the vision in my head into the
clear form to be developed in the future. | used

thumbnails for the pre-treatment of the painting.

| applied basic values for the representation
of the composition and the depth for future

painting. | applied these values in thumbnails

with a very small resolution by using the default

Chalk brush with active opacity. | tried to make

the basic landscape elements clear (foreground:

80% black, mid-ground: 40% black, and
background: 10% black). The red lines divided
the painting into thirds, which helped me place

the objects into focal points in the intersections.

Canvas

The chosen thumbnail helped me to achieve a
clear image of the painting. | saw it as a quiet,
historical landscape with hills. | decided to
highlight the history by including a castle as the

main theme in the scene.

The whole canvas was divided into thirds in
the golden section ratio. The circles indicated
the main parts in the scene, where | wanted to
focus the viewer’s eye. Into this part | placed
the castle and | put in something to represent a
human presence in the other parts. In this case

it was a ship sailing to the castle.

Sometimes | build up the elements of the
painting directly during its creation, according to
my internal feelings. These feelings suggest to
me that it'll be okay to incorporate them. Here
the background layer was filled with a color,

which | will describe in the next step.
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Perspective, Basic Colors and Shapes
| did not use an aggressive or dynamic camera
perspective in this scene. | wanted to make this
scene act peacefully and also make it easy for
the viewer to read. Therefore | chose a simple,

one-point perspective.

| started by blocking in the basic shapes of the
hills. | chose a basic color palette. | decided

on a significantly desaturated complementary
combination of blue-green for the sky and the
atmosphere, and red-orange to emphasize the
earthy shapes close to the camera. | liked the
contrast of colors and this kind of palette helped

me to achieve this.

Next | created a new layer where | built the
shapes up with quick strokes, working from the
background towards the camera using the Chalk

brush with opacity.

| applied the rough shapes of the hills towards
the camera with a cool blue-green color to
highlight the atmospheric perspective. | also
used some warm red-orange tones for the

landscape in the foreground.

Background - Sky

The sky was another important element of
this painting as the sky is the main element

of beauty in any environment design. For a
moment | turned off a layer with blocks of hills
and | began to build the sky in a similar way to

the layer below it.

| decided that the daytime sky should have
expressive clouds in the focal line above the
castle. | looked at reference images of the sky
on the internet for inspiration about the shape
of the clouds and shading. Inspiration is very
important; therefore it is good to still look at

references even if you know your subject well.

| applied the color to show light clouds, which
| chose as a source of light coming from the

right-hand side of the scene. | used the default
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Chalk brush with active opacity pressure. | tried
to keep this lighting for illuminating every object

in the scene.

Adding Detail to the Hills and
Foreground
After finishing off the sky details, | turned on the

layer with the blocks of hills to assess how the
sky worked with the scene objects. When | felt
it was okay | started to shape the foreground.

| looked at reference images for the hills in the

same way that I'd done previously for the sky.

| wanted earthy colors for the hills this time and
| tried to capture their structure. These hills were
the nearest objects to the camera and therefore
they needed to be more detailed than the hills in
the background, and of stronger contrast against

the background.

| used the default Chalk brush with active
texture in paint. It helped to deliver an
interesting structure. | fine-tuned other details

such as the shape of the river and its lighting.

The mountain on which | wanted to place the
castle was the next step in creating the scene.

At first it looked very flat and uninteresting. |
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used a basic hard brush with active pressure
opacity and a lighter value of blue to highlight
the area to simulate the lighting of the hill from
the source. This technique made the hill more

photorealistic.

Castle

In this step | focused on the primary element

of the scene: the castle. | placed it on a more
detailed hill, draped in the atmosphere. It had
to be a shade of blue to fit in with the rest of the

colors in the scene.

I made shapes for all the different parts of the
castle, such as the tower and pillars, which
then created the whole castle when combined
together. By painting every single part of the

castle separately, rather than painting a solid

concrete shape, | was able to play with the
castle design more effectively. It would have
been much more difficult to make any changes

to a solid shape.

| decided to place a town on the right side of
the hill as a sign of human presence. This small
town was built from rough details up to the final

shape and adapted to the atmospheric plane.
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Atmospheric Division of the Hills
and Boats

| divided the hills by placing fog between them to
achieve a sequence of hills in the perspective.

| used a large soft brush with a light color to
highlight the top of the hill contour. The hills did
not consist of one blue color, but their transitions

were more significant.

| decided to revive the river by placing in some
old boats, which brought a bit of narrative

and movement to the painting. The viewer’s
mind could create the main storyline, such as
expedition boats going to explore the castle.
Each scene should have some sort of story, like

it's a clip cut from the movie.

The procedure to add the boats was the same
as adding the castle. | made the shape of the
boat, added its lighting and | made a boat
reflection on the water. | also tried to make the
dynamics of the waves follow the movement of

the boats with a white color.

Trees
| started to add natural elements into the scene

by adding green colors in. To create the effect of

leaves | used some amazing vegetation foliage
brushes from the great artist Markus Lovadina

aka Malo: http://donmalo.deviantart.com

| like trees as a repeated element that supports
a painting’s depth. | worked up the tree trunks
and branches with a dark brown color. |
simulated the leaves with a foliage brush and
green color. | determined the values of the
individual trees in the scene according to their
position in the perspective. More contrasted
trees were added in the front and the ones in

the background had less contrast.

| decided to add a small number of human
beings to the scene to enrich the narrative. |

use humans them mainly to indicate the scale of
scenes, to give the viewer some impression of

the size of the environment.

Last Modified Scene Details

| decided to add a similar shape to the castle
in the final detailing of the scene. It served to
achieve a greater sense of depth within the
scene. The placement of such objects can
create a path for the viewer’s eyes to follow

through a painting.
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A quick touch-up of all the objects in the scene
was the last step before it was ready to be
finalized. | completed the shapes of the hills,
details of the foreground and the castle. Finally |

added the highlights with a distinct light color on

the river, hills, boats and people in the direction

of the light source.

Color Correction and Conclusion

The scene was done and finally | could make

color corrections. | really like to use these

because they can bring a painting together.

In this case, | didn’t use anything special. | just

used classic Color Balance to add highlights
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to the warm colors, and warm lighting and
shadows to the cold colors. | colored the
highlights with yellowish colors and for the
shadows | used some bluer tones. | also used
the Brightness/Contrast options to highlight the

values of the colors.

And as this was the last step, | used a Smart
Sharpen filter and also a Trace Contour filter, to
highlight the strokes. | made sun rays by doing
straight strokes away from the source and |
added bird shapes as the last element to bring

the image alive.
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Conclusion

In my opinion it is very fun to design these
kinds of scenes. Many times | have an idea

in my mind, which | would like to display.
These techniques allow me to do it. | hope
the techniques that | introduced in this project
overview have been interesting to you and will
be useful in the future when designing your

landscape speed paintings.

Byzwa Dher
Web: http://www.arte-grafik.com
Email: byzwadher@arte-grafik.com
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Ubermesserschmitt
Software Used: Photoshop

My Painting

The original plan when starting this image was
just to practice exaggerating a classical airplane
design and to create a vintage poster with some
retro-tag lines. At the time | was feeling kind of
guilty for not using the huge sketchbook | was
given at Christmas. Because of this | took a
break from my usual tiny pencil sketches and

started a bigger, more complete drawing.

After a few thumbnails where | tried to nail
down a pleasing silhouette and camera angle, |
sketched the drawing. The drawing you can see

in Fig.01 is about 20 x 25 inches in size.

The final aircraft design was like a bloated
plane where the engine was clearly visible

in places, almost like an American hot rod. It
was decorated with a savage-looking paint job
and equipped with a ridiculously overpowered
mini-gun (which would actually block the pilot’s
view, but it looked good so | left it in). The flying
squirrel was just for fun at this point. | changed
almost everything about it later, but by the end |

liked to think of it as the picture’s heart.

Before starting on the final image | usually try
out a few different color schemes to see what
will work in the composition. | love to use Corel
Painter to do this as the colors are incredibly fun
to handle (and mess around with). | ended up
with a muted, military green and silver for the
airplane, contrasting with a bold red backdrop,

slicing the workspace in two (Fig.02).

ha“ste:Digital Art Mastegsa\olume 7

The next step was to scan the drawing and put
it into Photoshop so | could start rendering. |
firstly painted below the sketch with a solid color
using the Lasso and Fill tools. In a layer above
this | started working in some form and volume,
and started painting in some lighting and detail
(Fig.03 — 04).

| slowly started to notice that the background

was looking a bit boring and began to think that
there was an opportunity to paint in something
awesome going on there. | took a little time to
generate some good ideas and to think of a new
composition, and then the idea came to me.

The re-imagined Messerschmitt should have an

interesting backdrop, so | enlarged the canvas
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on every side and started to block in some new
shapes (Fig.05).

What was once was a plain red shape now
became part of a huge sky vessel. | had to

be careful not to add too much detail to the
background because together with the saturated
colors, it could divert the viewer’s attention away
from the point of interest. By keeping it simple it
had more impact and provided a nice backdrop

for the main focal point.

Instead of another flat surface as a backdrop,
on the right | opened up a vast cloudscape,
which gave my image enormous depth. This
distance contrasted nicely with the proximity
of the objects on the left. Again, | used Painter
to help me choose the colors | wanted to use
(Fig.06 — 07).

You can do awesome things with Photoshop’s
Smudge tool, but whenever it comes to doing
soft-edged things such as fire or clouds, Painter

seems to work better for me.

The bright red ships in the background serve
two purposes. For a start, without them the

red space by the main focal point would be

confusing and seem strange. The other purpose
of the smaller ships is to show depth by way of

perspective.

When it came to painting the first of these
smaller ships something became quite clear. All
of these smaller ships needed to demonstrate

the same proportions and design. When
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something like this comes up in your paintings it
is always worth thinking about using 3D. Making
a quick ship in 3D was pretty swift (Fig.08).

After preparing the painting for the arrival of

this new element, | copied the 3D ship several
times and positioned the copies in places that
seemed to work well with the composition. This
process is really helpful because with one click
on the Render button you can create an armada
of ships with perfect perspective and proportions
(Fig.09).

Now my lonesome aircraft was just a small part

of a mighty fleet crossing the sky (Fig.10).

For the paint job on the red ships | found a nice
font that seemed to contrast with the overall war
theme. These sorts of contrasts always seem to

add some extra fun to an image.

P ee chapier Digital Art Mastersa\/olume 7
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| was almost done at this point, but the
composition still seemed a little dull and frozen.
To add the feeling of movement | added several
trails of steam evaporating from the engines. For
some of the objects that were moving quickly
(propeller, bat’s wings, etc.,) | used some Motion
Blur. Not too much though, because these filters

can quickly kill the painterly feeling.

One thing that can be great for unifying your
scene is to let the light bleed into the shadows.

To do this, copy and merge the flattened image,

and lay it on top of your layer stack. Then

apply some Gaussian Blur and set the layer to
Lighten. The higher the blur radius and opacity,
the stronger the blooming effect will be (Fig.11).
Be careful not to go crazy though, because if the

effect is too strong it can look really bad.

At this point the image was almost finished.
After taking a good look at the painting as a
whole, | found it kind of sad that there was no

sign of human inhabitants. So | made some last

minute changes and added a row of windows to
the nearest red ship, with some people staring

out through the glass (Fig.12).

When | got to this point | was happy that the
image was finished. | decided to totally change
the content during the process and turn it into
more of a scene. If you are tempted to do this
with one of your practice images then do so with
care, as it can prove risky with the overall focus
being lost. | decided to take this step however

and it worked out well, and was totally worth it!
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Tobias Trebeljahr

Web: http://www.trebelja.com

Email: tt@glarestudios.de
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Fdtotal.com

Is a resource website for the CG community;
amongst our growing number of products for CG
artists, we produce two monthly downloadable
PDF magazines — 2DArtist and 3DCreative.

We are based in the West Midlands, in the UK,
and our intention with our magazines is to make
each issue as full of great articles, images,
interviews and tutorials as possible. If you

would like more information on 3DTotal or our
magazines, or if you have a question for one our

team, please use the links below.
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http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor/Content Manager > Jess Serjent-Tipping
jess@3dtotal.com

Designer > Az Pishneshin

az@?3dtotal.com

Marketing > Emma Handley

emma@3dtotal.com

Partners

If you have a CG community website and would
like to support 3DCreative and/or 2DArtist
magazine by showing our banners, please

contact Simon at the email address above
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